Deploying Cisco MXE 3500 in Resource Manager Configuration

Revised: January 26, 2010, OL-21554-01

This section includes the following topics:

- About Cisco MXE 3500 Resource Manager Deployments, page 2-1
- Guidelines for Resource Manager Deployments, page 2-2
- Identifying Steps for Resource Manager Deployments, page 2-2
- Accessing Cisco MXE 3500 User Interfaces, page 2-5
- Installing the License on the Resource Manager Device, page 2-5
- Enabling System Administration E-mail Notifications, page 2-9
- Confirming Service Accounts, page 2-9
- Creating a Folder Attendant Directory and Watch, page 2-9
- Using Administrative Tools to Configure the Resource Manager Device, page 2-9
- Verifying Resource Manager Deployment, page 2-22

About Cisco MXE 3500 Resource Manager Deployments

A Cisco MXE 3500 Resource Manager (Resource Manager) deployment consists of one or more Cisco MXE 3500 devices running as a single group with one set of user accounts, job profiles, licensed features, and user interfaces. Resource Manager also provides user-management functionality, such as the ability to create users with specific roles and access to specific sections of the web UI.

There are two types of Cisco MXE 3500 devices in a Resource Manager deployment: a single Resource Manager and up to nine Resource Nodes.

- Resource Manager—Runs the Enterprise Control System (ECS), Configuration and Monitoring (CAM) service, and Local Control System (LCS) components on the same Cisco MXE 3500 device and is aware of all Resource Nodes in the group. The Resource Manager functions as a multinode manager by assigning various transcoding jobs to Resource Nodes, balancing the job loads uniformly based on the Capacity, Limit, and Expense values that you configure in the Resource Manager for each Resource Node.
Guidelines for Resource Manager Deployments

The following configuration guidelines and restrictions apply to Resource Manager deployments:

- To obtain a license for a Resource Manager deployment that includes all the Resource Nodes you purchased, you must complete the product license registration, as follows:
  1. Complete the product license registration, ensuring you have entered a MAC address for the Resource Manager device. The registration is complete when you receive a license by e-mail. Do not install this license because there are no Resource Nodes associated with it.
  2. Complete the product license registration for a Resource Node, ensuring that you enter the same MAC address that you entered for the Resource Manager. If you have only one Resource Node, you will install this license. Otherwise, discard the license.
  3. Complete the registration process for all the Resource Nodes in the group one by one: register and obtain the license for that registration before registering the next Resource Node. When you have obtained the license file for the final registration process, save the license file. This is the license that you will install in the Resource Manager.

- Resource Manager and Resource Nodes ship with the same Host name, mxe3500. Before you configure Hosts Settings, you must change the Host name to a unique name on each device.

- Resource Manager and Resource Nodes ship with DHCP enabled. If you use static IP addresses, disable DHCP and assign an IP address on each device before you configure Hosts Settings.

- All paths that you configure on the Resource Manager must be UNC paths, not local paths, because all nodes must be able to read across the network.

- MXE-Service is the default user account that is used to log in to all mxeservices. MXE-Service must have read/write access to all configured UNC paths and to IIS. Do not delete or modify this account; otherwise, the Cisco MXE 3500 may not work.

- We recommend that the Resource Manager and Resource Nodes remain on the same LAN because of the transfer of media files. If there are network delays, job timeouts and failures can occur.

- If a Resource Node fails, the Resource Manager transfers jobs to other available Resource Nodes without job loss; however, if the Resource Manager fails, no failover occurs.

- To enable a licensed feature, you must install the feature license on the Resource Manager. For information about deploying licensed features, see Chapter 3, “Deploying Licensed Features for Cisco MXE 3500.”

Identifying Steps for Resource Manager Deployments

Cisco MXE 3500 comes from the factory requiring you to perform the following mandatory steps before using the system. Optional deployment instructions are included, as well.
### Identifying Steps for Resource Manager Deployments

Before you begin deployment, see the “Example Workflow for a Three-Node Resource Manager Deployment” section on page 2-3 for an example deployment workflow.

#### Mandatory Deployment Steps
- Installing the License on the Resource Manager Device, page 2-5
- Configuring the Input and Output Media Directories, page 2-8
- Enabling System Administration E-mail Notifications, page 2-9
- Configuring System Settings for Resource Manager Deployments, page 2-15
- Configuring User Settings, page 2-19

#### Optional Deployment Steps
- Confirming Service Accounts, page 2-9
- Creating a Folder Attendant Directory and Watch, page 2-9
- Verifying Resource Manager Deployment, page 2-22
- Deploying Licensed Features for Cisco MXE 3500, page 3-1

### Example Workflow for a Three-Node Resource Manager Deployment

The following table provides an example workflow that identifies the mandatory steps that you must complete for a new, three-node Resource Manager deployment, which includes the Resource Manager node and two Resource Nodes.

<table>
<thead>
<tr>
<th>Task</th>
<th>Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td><strong>Step 2</strong></td>
</tr>
<tr>
<td>Set up the Resource Manager device:</td>
<td>Set up the Resource Nodes:</td>
</tr>
<tr>
<td>a. Configure a unique TCP/IP Host name.</td>
<td>a. Configure unique TCP/IP Host names.</td>
</tr>
<tr>
<td>b. If using static IP addresses, disable DHCP and assign an IP address.</td>
<td>b. If using static IP addresses, disable DHCP and assign IP addresses.</td>
</tr>
<tr>
<td><strong>Quick Start Hardware Installation Guide</strong> for Cisco Media Experience Engine 3500</td>
<td><strong>Quick Start Hardware Installation Guide</strong> for Cisco Media Experience Engine 3500</td>
</tr>
</tbody>
</table>
## Chapter 2      Deploying Cisco MXE 3500 in Resource Manager Configuration

### Send document feedback to mxe-doc@cisco.com.

<table>
<thead>
<tr>
<th>Task</th>
<th>Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 3</strong> Obtain the Resource Manager license:</td>
<td>- Software License Claim Certificate</td>
</tr>
<tr>
<td>1. Obtain a Resource Manager MAC address. Note: You must use the same MAC address for each license that you request.</td>
<td>- Product Authorization Key (PAK) for the Resource Manager</td>
</tr>
<tr>
<td>2. Get the PAK for the Resource Manager device.</td>
<td>- Obtaining the Resource Manager MAC Address, page 2-5</td>
</tr>
<tr>
<td>3. Register the Resource Manager device on Cisco.com.</td>
<td>- Obtaining the License for the Resource Manager, page 2-6</td>
</tr>
<tr>
<td>4. Obtain the Resource Manager license by e-mail. This license is valid only for the Resource Manager device as a single node. Discard this license.</td>
<td></td>
</tr>
<tr>
<td><strong>Step 4</strong> Obtain the updated Resource Manager license that includes two additional Resource Nodes:</td>
<td>- Software License Claim Certificate</td>
</tr>
<tr>
<td>1. Obtain the Resource Manager MAC address that you used to obtain the Resource Manager license.</td>
<td>- PAK for the Resource Node</td>
</tr>
<tr>
<td>2. Get the PAK for the Resource Node.</td>
<td>- Obtaining the Resource Manager MAC Address, page 2-5</td>
</tr>
<tr>
<td>4. Obtain the updated Resource Manager license by e-mail. This license is valid only for the Resource Manager node and one Resource Node for a total of two licensed nodes. Discard this license.</td>
<td></td>
</tr>
<tr>
<td>5. Repeat Step 1 through Step 3 for the second Resource Node, ensuring that you use the correct PAK and MAC address.</td>
<td></td>
</tr>
<tr>
<td>6. Obtain the updated Resource Manager license by e-mail. This license is valid for the Resource Manager and two Resource Nodes for a total of three licensed nodes. This is the license you will install on the Resource Manager device.</td>
<td></td>
</tr>
<tr>
<td><strong>Step 5</strong> Install the license on the Resource Manager device.</td>
<td>Installing the License on the Resource Manager, page 2-8</td>
</tr>
<tr>
<td><strong>Step 6</strong> Configure the mandatory settings on the Resource Manager device:</td>
<td>- Configuring the Input and Output Media Directories, page 2-8</td>
</tr>
<tr>
<td>- Input and output directories</td>
<td>- Enabling System Administration E-mail Notifications, page 2-9</td>
</tr>
<tr>
<td>- E-mail server</td>
<td>- Configuring System Settings for Resource Manager Deployments, page 2-15</td>
</tr>
<tr>
<td>- System Settings</td>
<td>- Configuring User Settings, page 2-19</td>
</tr>
<tr>
<td>- Hosts Settings</td>
<td></td>
</tr>
</tbody>
</table>
Accessing Cisco MXE 3500 User Interfaces

For information about accessing the user interfaces on the Resource Manager device, see the “Accessing the Cisco MXE 3500 Web User Interface” section on page 1-2 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

Note

- You can access Cisco MXE 3500 user interfaces only on the Resource Manager device and not on Resource Nodes.
- A graphic with either “Resource Manager” or “Resource Node” is present on the desktop of each appliance to identify its Cisco MXE 3500 device type and facilitate identification. We recommend that you do not remove the desktop background image. You can also determine the function of a node by its enabled services. See also: Confirming Service Accounts and Identifying Device Type, page 1-8.

Installing the License on the Resource Manager Device

For Resource Manager deployments, you install the license only on the Resource Manager device. Resource Nodes do not require license installation, but you must register each node in the group to obtain a Resource Manager license that supports all the nodes you purchased.

This section includes the following topics:

- Obtaining the Resource Manager MAC Address, page 2-5
- Obtaining the License for the Resource Manager, page 2-6
- Installing the License on the Resource Manager, page 2-8

Obtaining the Resource Manager MAC Address

Note

Licensing requires that you provide either of the two Cisco MXE 3500 Ethernet MAC addresses and that, once you choose a MAC address to provide, you use the same MAC address for all license requests—initial or upgrade.

Procedure

Step 1
Boot the Resource Manager device.

Tip
The desktop image of this device shows Resource Manager.

Step 2
Browse to C:\Program Files\Cisco\Media Experience Engine\bin.

Step 3
Double-click lmtools.exe.

Step 4
Select the System Settings tab, shown in Figure 2-1.
Installing the License on the Resource Manager Device

---

**Send document feedback to mxe-doc@cisco.com.**

---

**Chapter 2      Deploying Cisco MXE 3500 in Resource Manager Configuration**

---

**Step 5**  
Copy one of the Ethernet addresses that display between quotes in Ethernet Address field. You will use this number to generate a Cisco MXE 3500 Resource Manager license. See also: Obtaining the License for the Resource Manager, page 2-6.

---

**Tip**  
You can find the MAC addresses and statuses of the Ethernet adapters by running the command prompt (double-click the Command Prompt shortcut on your desktop) and executing the command `ipconfig /all`. The command output shows each Ethernet adapter’s status and the MAC address (under Physical Address).

---

**Obtaining the License for the Resource Manager**

To obtain the license for a Resource Manager deployment through the Cisco.com website, you must first register the Resource Manager device; then, register each Resource Node that you purchased by using the MAC address of the Resource Manager device.

This registration process is required to associate the number of Resource Nodes that you purchased with the MAC address of the Resource Manager device; this association results in multiple licenses being sent to the e-mail address that you use for registration.

---

**Note**  
Licensing requires that you provide either of the two Cisco MXE 3500 Ethernet MAC addresses and that, once you provide a MAC address, you must provide the same MAC address for all license requests—both initial or upgrade.
You must complete the registration of the Resource Manager device first and obtain the license for that registration process before you register the Resource Node(s), completing registration and obtaining the updated license files one at a time. You will install the license that you receive for the final completed registration process on the Resource Manager device.

Before You Begin
- You must have an account on Cisco.com to access the license website.
- Obtain the Cisco MXE 3500 MAC address of the Resource Manager device. See also: Obtaining the Resource Manager MAC Address, page 2-5.
- Obtain the Product Authorization Keys (PAKs) for the Resource Manager device and Resource Nodes, which is located on the Software License Claim Certificates that shipped with your devices.
- Ensure that you understand the licensing process for Resource Manager deployments. See also: Guidelines for Resource Manager Deployments, page 2-2.

Procedure

**Step 1** Go to http://www.cisco.com/go/license.

**Step 2** Enter the PAK for the Resource Manager device, or if you have already licensed the Resource Manager, enter the PAK for the Resource Node.

**Step 3** If you are using the Resource Manager device to access the registration website, press the Enter key; otherwise, click the Submit button.

**Step 4** Follow the on-screen prompts and ensure that you use the MAC address from the Resource Manager device when prompted.

**Step 5** After registration, you will receive an e-mail with a license file.

  a. If the license file is only for the Resource Manager device, discard this license. Return to Step 1 and complete the registration process for a Resource Node, ensuring that you use the PAK for the Resource Node.

  b. If this license file is for a Resource Node and you have additional Resource Nodes to register, discard this license. Return to Step 1 and complete the registration process for another Resource Node, ensuring that you use the PAK for the Resource Node.

  c. If this license file is for the final Resource Node, save the license file; you will install this license on the Resource Manager device, as it includes a valid license for the Resource Manager device and each Resource Node in the group.

**Note** We recommend that you save the license file in a secure location. If the license file is lost, it can take up to one business day to get another copy.

**Troubleshooting Tips**
If you experience problems with the registration websites or if you have additional questions, for a prompt response, please open a Service Request using the TAC Service Request Tool at http://tools.cisco.com/ServiceRequestTool/create/DefineProblem.do.

Please have your valid Cisco ID and password available. As an alternative, you may also call one of the these numbers:
Installing the License on the Resource Manager

Before You Begin

- Obtain the Cisco MXE 3500 license file for the Resource Manager device. See also: Obtaining the License for the Resource Manager, page 2-6.
- Only install the license file on the Resource Manager device.

Procedure

Step 1 Log in to the Resource Manager device.
Step 2 Copy the generated mxe.lic file into the license directory: C:\Program Files\Cisco\Media Experience Engine\license
Step 3 Reboot the Resource Manager device.

Configuring the Input and Output Media Directories

For the Resource Manager to manage input and output media, you must configure the input and output directories.

Before You Begin

Ensure that any directories that you are going to configure exist and are shared.

Procedure

Step 1 Log into the UI at http://localhost/mxeUI on the Resource Manager or click the Cisco MXE Web Interface icon on its desktop.
Step 2 From the Toolbox, click Administration > System.
Step 3 In the following fields of the Input section, enter the directories where nodes will obtain input media. For more information, see the “Input Section” section on page 2-16.
  - Bumper
  - common
  - Media
  - Watermark
Step 4 In all the fields in the Output section, enter the directories where nodes will store output media. For more information, see the “Output Section” section on page 2-17.
Enabling System Administration E-mail Notifications

For information about configuring e-mail notifications on the Resource Manager device, see the “Enabling System Administration E-mail Notifications” section on page 1-7 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

Note
We recommend that you configure an e-mail server so that you receive job completion or failure notifications.

Confirming Service Accounts

For information about service accounts on the Resource Manager or Resource Node, see the “Confirming Service Accounts and Identifying Device Type” section on page 1-8 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

Tip
You can determine the Cisco MXE 3500 device type (Resource Manager or Resource Node) by verifying which services are enabled.

Creating a Folder Attendant Directory and Watch

For information about creating a Folder Attendant directory and watch on the Resource Manager device, see the “Creating a Folder Attendant Directory and Watch” section on page 1-10 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

Note
Make sure that the service accounts have appropriate access to the UNC path that you configure as the Directory Path for the Folder Attendant directory. See also: Confirming Service Accounts and Identifying Device Type, page 1-8.

Using Administrative Tools to Configure the Resource Manager Device

The Administration section of the Toolbox allows you to configure the following settings:

- Host Settings for Resource Manager Deployments, page 2-10
Using Administrative Tools to Configure the Resource Manager Device

- System Settings for Resource Manager Deployments, page 2-15
- User Settings, page 2-19
- Role Settings, page 2-20
- Profile Space Settings, page 2-21
- User Metadata Settings, page 2-22
- IP Capture Settings, page 2-22

Note You must have Admin Tools permission to configure these settings.

Host Settings for Resource Manager Deployments

The Host Administration page allows administrators to configure Cisco MXE 3500 to work with computers on the network. Host is simply another word for the computer or system that runs Cisco MXE 3500. The Host Administration page is used to tell the Enterprise Control System (ECS) what the Hosts are capable of running (what the load capacity of the machine is and what software is installed).

Access this page from the Toolbox by clicking Administration > Host. Select a Host to display summary information about workers configured on that Host, delete a Host, or edit the configuration of a Host.

See also: Configuring Hosts Settings for Resource Manager Deployments, page 2-14 and Understanding Capacity, Expense, and Limit, page 2-13
Figure 2-2 shows the Host settings.

Table 2-1 describes the Hosts settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>This is the hostname or computer name of the Resource Manager or Resource Node device. The computer name and the Host name must match exactly.</td>
</tr>
<tr>
<td>Note</td>
<td>The Resource Manager and each Resource Node in the group must have unique names.</td>
</tr>
<tr>
<td>Tip</td>
<td>To verify the computer name of a Windows Server computer, right-click the My Computer icon on either your desktop or in your Start Menu, select Properties, then select the Computer Name. Alternately, type the hostname command at the command prompt to display the computer name.</td>
</tr>
</tbody>
</table>
**Table 2-1  Hosts Settings and Descriptions for Resource Manager Deployments (continued)**

| Status | Displays the status of the Host: Enabled or Disabled. To change the status, right-click the Host or click Host Options, and select Enabled or Disabled.  
**Note** If the status is disabled, jobs will not schedule on that Cisco MXE 3500 node. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>TCP port that the LCS is listening on. The default is 3500.</td>
</tr>
</tbody>
</table>
| Capacity | Reflects a numeric value assigned for the total available processing capacity of the displayed Host. Valid values are 0-99.  
Capacity can be any number for a given Host, but it is important that all Hosts be numbered according to the same standards. For example, for one particular Host it will not matter if the total capacity is set at 5 or at 10. However, if there is another Host that has twice the capacity, the capacity of both Hosts should be listed in common terms. So, a Host that is twice as powerful would have a capacity of 10 if the first Host was 5, or 20 if the first Host was 10.  
Capacity is directly related to processor capacity, but may also be affected by drive speed, network congestion, and other factors. All of the factors that affect the amount of work a particular Host can do efficiently should be considered when assigning a capacity value.  
**Note** Numbers between 5 and 30 are typically best. Setting this to a high number > 30 can make the system status monitor hard to read. |
| Temp Directory (UNC Name) | Specifies the directory where temporary files and preprocessor output will be stored while the job is processing. This must be a UNC path, not a local path, so that other Hosts will be able to access files written to this directory. MXE-Service must also have read/write access to this directory.  
**Note** Unless the Preprocessor box in the Output tab is checked to specify that preprocessor files should be saved, files written to the Temp Directory will be deleted automatically when encoding has completed. |
| Worker Status |  
- Green checkmark: Indicates that the worker listed to the right is configured to run on the displayed Host and that it is currently online and available to process tasks.  
- Red X: Indicates either:  
  - The worker listed to the right is configured to run on the displayed Host but is currently offline and cannot be contacted by the ECS.  
  or  
  - The worker is not enabled or configured. |
| Worker Licensed | Displays a list of all workers that have been configured to run on the displayed Host. Indicates the number of concurrent instances of this worker type (example: prefilter, encoder, distribution) that can be running on the system (all nodes controlled by that ECS). This value is defined in the Cisco MXE 3500 license file. |
Table 2-1  Hosts Settings and Descriptions for Resource Manager Deployments (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Displays the maximum number of a particular worker that can be run simultaneously on the displayed Host. Valid values are 0-99. See also: Understanding Capacity, Expense, and Limit, page 2-13 and Figure 2-2, Host Settings for Resource Manager Deployments</td>
</tr>
<tr>
<td>Expense</td>
<td>The expense of a worker is expressed as a portion of Host capacity. Valid values are 0-99. See also: Understanding Capacity, Expense, and Limit, page 2-13 and Figure 2-2, Host Settings for Resource Manager Deployments</td>
</tr>
<tr>
<td>Capture Name</td>
<td>This setting is not available in Cisco MXE 3500 Release 3.0. Defines the name associated with a live capture worker. Because Hosts can have more than a single video capture card and can be configured to run more than one Live capture worker, the Capture Name is required in order to identify the specific capture card used by the worker. This is only displayed for Live capture workers.</td>
</tr>
<tr>
<td>Capture Type</td>
<td>This setting is not available in Cisco MXE 3500 Release 3.0. Type of capture card (DV, DVCAM, AJA-SDI, Custom, etc.). Selection of a non-custom value will predefine the audio and video channel.</td>
</tr>
<tr>
<td>Video CH/Audio CH</td>
<td>This setting is not available in Cisco MXE 3500 Release 3.0. Displays Video Channel and Audio Channel for each Live-capture worker.</td>
</tr>
</tbody>
</table>

Understanding Capacity, Expense, and Limit

For information about Cisco MXE 3500 components, such as workers and ECS, see the User Guide for Cisco Media Experience Engine 3500 on Cisco.com, or click Help in the UI.

See also: Host Settings for Resource Manager Deployments, page 2-10.

The ECS uses capacity and expense to assign tasks to specific workers on specific Hosts to keep jobs moving through the encoding process efficiently and to ensure that no single Host is over-burdened, thereby preventing bottlenecks.

Capacity is directly related to processor capacity but may also be affected by drive speed, network congestion, and other factors. All the factors that affect the amount of work a particular Host can do efficiently should be considered when assigning a capacity value.

Capacity can be any number for a given Host, but all Hosts should be numbered by using the same standards. For example, it does not matter that the total capacity is set to 5 or 10 for one particular Host. However, if there is another Host that has twice the capacity, then the capacity of both Hosts should be listed in common terms. That is, a Host that is twice as powerful should have a capacity of 10 if the first Host is 5 or a capacity of 20 if the first Host is 10. In practical terms, numbers between 5 and 30 are better.

The expense of a worker is expressed as a portion of Host capacity, as shown in the following examples:
Expense will be different for different types of workers, and the processing power that is required by a particular type of worker may not always be the same. For example, MPEG encoding is more labor-intensive than Microsoft encoding, so an MPEG worker is given a higher expense than a Microsoft worker.

Limit is used with Capacity and Expense to accommodate expense differences. For example, running one particular type of worker takes a certain expense amount, and running two may require double that amount. However, when a certain number is exceeded, the efficiency may degrade: Everything is fine until the fourth instance of the same worker is triggered. After this, the Host bogs down and performance suffers. Setting the Limit for this particular worker to three will prevent the ECS from triggering the fourth worker even if there is sufficient capacity to accommodate the normal expense of the fourth instance. Because the expense would dramatically increase if the fourth worker were triggered, setting the Limit to three creates a threshold for the normal expense of a worker and sets an upper limit on the number of instances that can run at the same time.

Configuring Hosts Settings for Resource Manager Deployments

Use this procedure to configure the Hosts settings for all the nodes in your Resource Manager deployment, including the Resource Manager device.

See also: Understanding Capacity, Expense, and Limit, page 2-13 and Host Settings for Resource Manager Deployments, page 2-10.

Before You Begin

1. Ensure that you change the TCP/IP Host name to a unique name on each Cisco MXE 3500 device. You will use these names during Hosts settings configuration.

2. Hosts settings configuration is required for both the Resource Manager device and each Resource Node.

3. Configure the Hosts settings for the Resource Manager device before you configure the settings for the Resource Nodes.

Procedure

Step 1 From the Toolbox, click Administration > Host. See also: User Settings, page 2-19.

Step 2 Create a new Host:

   a. From the Host Administration menu, click the arrow to the right of Host Options > New. The New Host pop-up displays.

<table>
<thead>
<tr>
<th>Host Capacity</th>
<th>Portion of Total Processing Power Required</th>
<th>Worker Expense</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Half</td>
<td>50</td>
</tr>
<tr>
<td>6</td>
<td>Half</td>
<td>3</td>
</tr>
<tr>
<td>9</td>
<td>One third</td>
<td>3</td>
</tr>
<tr>
<td>6</td>
<td>One third</td>
<td>2</td>
</tr>
</tbody>
</table>
**Note**  Configure the Host settings for Resource Manager device first; then, configure the settings for the Resource Nodes.

b. In the Host Name field, enter the **Host** name. This name must be a valid computer name that you configured for the Resource Manager device or the Resource Node if you have configured the Resource Manager.

c. Enter the **Capacity**.

d. In the Temp Directory field, enter the UNC path for the temp folder on the Host that you configured in Step b., as follows: `\host_name\temp`.

e. Click **Create**. The new Host displays in the Hosts pane.

**Step 3** Add workers to the Host that you created in **Step 2**:

a. Select each Worker that is assigned to the Host.

b. Click **Permit** or click **Permit All**.

**Note**  The list of workers displayed is controlled by your license level. If you select the Permit All option, only all non-Live workers will be permitted. Live workers require manual entry of additional data.

**Step 4** Configure the Limit, Expense, and live capture information for each worker:

a. Click each **Worker** and click **Edit**. The Edit worker pop-up displays.

b. Enter the **Limit** and the **Expense**.

c. For live captures, enter Capture Name, Capture Type, Video CH, and Audio CH.

d. Click **Save**.

**Step 5**  At the top of the page, click **Apply Configuration**.

**Step 6**  (Optional) Verify that the node is successfully added by selecting Monitoring > System Status from the Toolbox. Host names display in the first column of the System Status Monitor.

**Step 7**  Repeat **Step 2** through **Step 5** for each node that you purchased.

---

**System Settings for Resource Manager Deployments**

The Administration section of the Toolbox is used to configure the Cisco MXE 3500 Resource Manager device. You must have Admin Tools permission to configure these settings.

Access this page from the Toolbox by clicking **Administration > System**.

The System page is made up of the following sections:

- **Input Section**, page 2-16
- **Output Section**, page 2-17
- **General Settings Section**, page 2-18
- **Status Settings Section**, page 2-18
- **Data Purging Section**, page 2-18
Input Section

Note

Directory values must be UNC paths to a network share.

Figure 2-3 shows Input section settings.

**Figure 2-3 Input Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bumper/Trailer Directory</td>
<td>Defines the location of files that can be used as bumpers or trailers to clips encoded with the Cisco MXE 3500. The Bumper/Trailer Directory controls the directory path where the Cisco MXE 3500 searches for files displayed in the Bumper Source and Trailer Source fields in the Preprocessing Profile page. The Bumper/Trailer Directory value can be entered either as a UNC path to a network share or to a mapped drive in the case of a deployment using a storage area network (SAN) or a single node deployment. The Bumper/Trailer Directory location must be accessible to all hosts.</td>
</tr>
<tr>
<td>Common Directories</td>
<td>Defines the directories where media files will be stored. Multiple directories can be defined. A semi-colon is used to separate directory entries. Directory values must be UNC paths to a network share.</td>
</tr>
<tr>
<td>Media Directory</td>
<td>Defines the directory where media files that will be submitted to the Cisco MXE 3500 are stored. The Media Directory controls the directory path where the Cisco MXE 3500 searches for files displayed in the Source box on the File Submission page. The Media Directory value can be entered either as a UNC path to a network share or to a mapped drive in the case of a deployment using a storage area network (SAN) or a single node deployment. The Media Directory location must be shared and accessible to all Hosts. Directory values must be UNC paths to a network share.</td>
</tr>
</tbody>
</table>
Output Section

Output Directories define the location the Cisco MXE 3500 will use to save files of each encoding format supported by the licensing levels of your Cisco MXE 3500 system. Encoded files will be saved to the defined directories when either no Distribution > Output Profile is included in the Job Profile or when the checkbox in the Save Local File section of the Output Profile has been checked.

Table 2-2  Input Settings and Descriptions for Resource Manager Deployments

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Directory</td>
<td>Defines the default path the ECS will use to search for Job Profiles when processing a submitted job.</td>
</tr>
<tr>
<td>Valid Input Extensions</td>
<td>Defines the list of valid extensions for files in Common Directories. Only files with extensions listed in this field will be displayed in the Selection List window in the Input section of the File Job Submission form. A semi-colon is used to separate file-extension entries.</td>
</tr>
<tr>
<td>Watermark Directory</td>
<td>Defines the location of files that can be used as watermarks for clips encoded with the Cisco MXE 3500. The Watermark controls the directory path where the Cisco MXE 3500 searches for files displayed in the Source drop-down in the Watermark section of the Preprocessing Profile page. Directory values must be UNC paths to a network share. The Watermark Directory location must be accessible to all hosts.</td>
</tr>
</tbody>
</table>

Note: All directory values must be a UNC path to a network share.
Figure 2-4 shows the Output section settings.

**General Settings Section**

For information about General Settings configuration on the Resource Manager device, see the “General Settings Section” section on page 1-21 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

**Status Settings Section**

For information about Status Settings configuration on the Resource Manager device, see the “Status Settings Section” section on page 1-22 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

**Data Purging Section**

For information about Data Purging Settings configuration on the Resource Manager device, see the “Data Purging Section” section on page 1-22 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

**Audio Capture Section**

For information about Audio Capture Settings configuration on the Resource Manager device, see the “Audio Capture Section” section on page 1-23 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”
User Settings

The User Administration page is used by administrators to set user access and permissions. Access this page from the Toolbox by clicking Administration > User.

The top pane of User Administration displays users that have been created. The lower pane displays the permissions for each user.

The Cisco MXE 3500 comes with one predefined user:

- **admin**: The default password is also admin. We recommend that your Administrator immediately change the admin password.

Upon receipt of your system, the predefined admin user is the only user who can perform Folder Attendant administrative tasks such as creating users, assigning roles, deleting users, and denying or removing user permissions. **Do not delete the predefined admin user until you have created at least one new admin user.**

The New or Edit Users pop-up, shown in Figure 2-5, allows you to create and modify system users.

![Figure 2-5 User Settings](image)

Table 2-3 describes the settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>From the menu bar, click New, or select the user and then click Edit. The New or Edit User pop-up displays. Enter a name for the user.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter a password for the new user.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Re-enter the password to confirm it.</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter the first name of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the last name of the user.</td>
</tr>
</tbody>
</table>
Chapter 2  Deploying Cisco MXE 3500 in Resource Manager Configuration

Using Administrative Tools to Configure the Resource Manager Device

Role Settings

Each Cisco MXE 3500 user is assigned a role that controls their level of access to the various system features.

Access the Role Administration page from the Toolbox by clicking Administration > Role.

The top pane of the Role Administration page displays roles that have been created. The lower pane displays the permissions for each role.

There are three predefined roles:

- **admin**: Set up with permission to access all features
- **operator**: Set up with permission to access Job Profile editing but not task profile editing features
- **user**: Set up with permission to access all features, except administrative

The New or Edit Role pop-up, shown in Figure 2-6, allows you to create and modify system users.

![Figure 2-6  Role Settings](image)

After creating a role, the System Administrator sets permissions for that role. Each role is allowed or denied permission to use the following Cisco MXE 3500 features:

- Admin Tools: Provides access to the Cisco MXE 3500 administrative tools
- Folder Attendant: Provides access to Folder Attendant
- Job Profile Editing: Provides access to Job Profile editing functionality
- Monitoring: Provides access to Monitoring functionality
- Monitoring (Advanced): Allows a user to reschedule, stop, delete, etc.
- Reporting: Provides access to reporting functionality
- Submission: Provides access to submission tools
- Task Profile Editing: Provides access to profile editing functionality

The permissions for a selected role are displayed at the bottom of the Role Administration page.

<table>
<thead>
<tr>
<th>E-mail</th>
<th>Enter the e-mail address of the user.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>Select the role from the drop-down menu. The role defines the level of access the user has to Folder Attendant functions. Roles are defined at the time of deployment and are normally: Administrator and User.</td>
</tr>
</tbody>
</table>

Table 2-3  User Settings and Descriptions
Table 2-4 describes the columns in the permissions table.
The red X indicates that permissions for that feature are denied, and the green check mark indicates that the selected user has permissions to access the feature.

### Table 2-4  Role Settings and Descriptions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Shows the default value for the permissions that are shipped with the Cisco MXE 3500.</td>
</tr>
<tr>
<td>Role</td>
<td>Shows the permissions set for the Role. Permissions set for the role override the Default permissions. The Role permissions specified in this column are set from the Role Administration page.</td>
</tr>
<tr>
<td>User</td>
<td>Shows the permissions set for the selected user. Permission set for the user override the Role permissions.</td>
</tr>
<tr>
<td>Allow</td>
<td>The actual permissions set for the selected user.</td>
</tr>
</tbody>
</table>

### Profile Space Settings

The Profile Administration page allows you to manage multiple profile directories within the system. The Cisco MXE 3500 is shipped with a single profile directory. The initial database setting for profiledir is:

```
C:\Program Files\Cisco\Media Experience Engine\profiles
```

The Cisco MXE 3500 uses the system setting-configured profile directory to access the list of Job Profiles. However, you may want to maintain separate profile directories for separate groups or for separate customers.

You can create as many Profile Spaces as you need, but the Cisco MXE 3500 will check to see that each profile directory exists at the time of creation.

Your Cisco MXE 3500 session links to one Profile Space at a time, thereby determining the profiles that you can view from the Profile Browser.

Access the Profile Administration page from the Toolbox by clicking Administration > User.

💡 **Tip**
You can change your working Profile Space at any time by clicking Tools > Select Profile Space.

The New or Edit Profile Space pop-up, shown in Figure 2-7, allows you to create and modify profile spaces.

![Profile Space Settings](image-url)
Table 2-5 describes the settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name.</td>
</tr>
<tr>
<td>Directory</td>
<td>Enter a verifiable directory.</td>
</tr>
</tbody>
</table>

**User Metadata Settings**

This User Metadata Administration page allows you to create custom name/value pairs that can be submitted with each job (and each task in the job). This custom metadata is returned in detailed job status including the HTTP POST job-status XML. This metadata (if submitted) is also stored in the database for each job and can be used for reporting purposes (like tracking which organization submitted which jobs) or (via HTTP POST) where it is passed back to other systems (like Velocity).

For information about User Metadata settings configuration on the Resource Manager device, see the “User Metadata Settings” section on page 1-24 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

**IP Capture Settings**

Cisco MXE 3500 enables ingest of Live MPEG2 Transport streams over UDP/IP with management, configuration, and status that enables general use of this feature. IP captures are limited to transport streams with MPEG2 video and AC3/Layer2/AES3 audio essences.

The IP Capture Configuration page is used by administrators to add, edit, or delete an IP capture source.

For information about IP Capture settings configuration on the Resource Manager device, see the “IP Capture (Live Streaming) Settings” section on page 1-25 in Chapter 1, “Deploying Cisco MXE 3500 in Standalone Configuration.”

**Verifying Resource Manager Deployment**

To ensure your system has been correctly deployed and configured, perform the following tests:

- **Test 1: Submit a Job Using File Job Submission**
- **Test 2: Submit a Job Using Folder Attendant**
- **Test 3: Verify a Licensed Feature is Enabled**

**Test 1: Submit a Job Using File Job Submission**

**Before You Begin**

- In the C:\ProgramFiles\QuickTime folder, select Sample.mov, and copy the file to the C:\Media folder.
- In the C:\media folder, make one copy of the Sample.mov file for each Resource Node in the group. For example, if you have four nodes, make four copies.
Verifying Resource Manager Deployment

Procedure

Step 1  Access the UI. See also: Accessing the Cisco MXE 3500 Web User Interface.
Step 2  From the Toolbox, expand Submission, and click File. The File Job Submission page displays.
Step 3  In the Profile section, choose Cable_Broadband.job.awp.
Step 4  In the Input section, complete the following tasks:
   a. Click Browse.
   b. Browse to |Resource_Manager_IP_Address|media and select all the copies of the Sample.mov file.
   c. Click Add File(s) to move files from your media directory to the Media Source box.
Step 5  Click Submit.
Step 6  From the toolbox, select View > Monitoring > Job Status.
Step 7  Continue watching the Job Status window to make sure the job completes.
Step 8  Browse to |Resource_Manager_IP_Address|output, locate the multiple File|FileName.Sample.Cable_Broadband.Cable_Broadband.wmv files, and play the files. Accept any warning messages or alerts Windows Media Player may display.
Step 9  To determine which transcoding job a Resource Node has completed, log in to a Resource Node and browse to the C:\ProgramFiles\Cisco\Media Experience EngineLog folder. Then, Open the LCS log for the current date, and search for “PP Input” to see the files were transcoded by that particular Resource Node.

Test 2: Submit a Job Using Folder Attendant

Before You Begin
- In the C:\ProgramFiles\QuickTime folder, select Sample.mov, and copy the file to the C:\Media folder.
- In the C:\media folder, make one copy of the Sample.mov file for each Resource Node in the group. For example, if you have four nodes, make four copies.

Procedure

Step 1  Access Folder Attendant. See also: Accessing the Cisco MXE 3500 Tools.
Step 2  Add a directory for the Folder Attendant to monitor.
   a. From the Toolbox, click Folder Attendant.
   b. From the Directory drop-down menu, select Add. The Directory fields display on the Folder Attendant Administration page.
   c. In the Directory Path field, enter C:\media and complete other fields as needed.
Step 3  Add a watch for the directory:
   a. From the Toolbox, click Folder Attendant.
   a. Highlight the Directory for which you want to add a watch, and from the Watch drop-down, click Add. The Watch fields display on the Folder Attendant Administration page.
b. In the Watch Extensions field, enter MPEG-4.
c. In the Job Profile field, select Cable_Broadband.
d. Complete other fields as needed.

Step 4  From the Toolbox, select Monitoring > Job Status.

Step 5  Drag all the copies of the Sample.mov file from the C:\media folder to the \\Resource_Manager_IP_Address\watch folder.

Step 6  Watch the Job Status pane to make sure the job starts and completes.

Step 7  Browse to \Resource_Manager_IP_Address\output, locate the multiple FileName.Sample.Cable_Broadband.Cable_Broadband.wmv files, and play the files. Accept any warning messages or alerts Windows Media Player may display.

Step 8  To determine which transcoding job a Resource Node has completed, log in to a Resource Node and browse to the C:\ProgramFiles\Cisco\Media Experience Engine\log folder. Then, Open the LCS log for the current date, and search for “PP Input” to see the files were transcoded by that particular Resource Node.

Test 3: Verify a Licensed Feature is Enabled

- To verify that the Live Ingest feature is enabled after you install a feature license, see the following sections:
  - Configuration Workflow for Cisco MXE 3500 Deployments with Live WMV IP Streaming, page 3-3
  - Configuration Workflow for Cisco MXE 3500 Deployments with Live Flash8 and H.264 IP Streaming, page 3-5

- To verify that the Speech to Text or Graphics Overlay feature is enabled after you install a feature license, see the following sections:
  - Configuration Workflow for Speech-to-Text Conversion, page 3-7
  - Configuration Workflow for the Graphic Overlay Feature, page 3-9